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 مقدمه 

های فنی مرتبط با طراحی و اجرای ای، و حساسیتنامههای ساختمانی، تنوع گسترده الزامات آیینهای اخیر، پیچیدگی روزافزون پروژهدر سال

های اجرایی، پیامدهای جدی برای ایمنی سازی، بارگذاری، تحلیل، طراحی یا تهیه نقشهترین خطا در مدل سازه باعث شده است که کوچک

به همراه داشته باشد. در چنین شرایطی، وجود یک »چارچوب استاندارد« برای کنترل مراحل طراحی و تهیه   ا راهبرداری از آنها و بهرهسازه

 .مدارک مهندسی، ضرورتی انکارناپذیر است

برای کنترل تمام مراحل طراحی    ایجاد یک نظام یکپارچه، کاربردی و قابل استنادبا هدف    کنترل  714جدول و بیش از    158با    حاضرمجموعه  

(، و استانداردهای ۲8۰۰،  7،  1۰،  ۹،  ۶های ملی )مباحث  نامههای بتنی و فولادی تدوین شده است. تلفیق تجربه مهندسی، الزامات آیینسازه

های نظام مهندسی، ناظران عالی، و ، این مجموعه را به مرجعی قابل اتکا برای مهندسان طراح، بازبینAISC و ACI 318-25 المللی نظیر بین

 .دانشجویان تحصیلات تکمیلی تبدیل کرده است

و بارهای ثقلی،  Mass Source نادرست تعریف از ها  است. بسیاری از اشتباهات رایج در پروژه پیشگیری از خطاها بر پایه لیستماهیت چک

های اجرایی های برشی و خمشی، یا ناسازگاری بین دفترچه محاسبات و نقشه، انتخاب نادرست مقاطع، ضعف در کنترلP–Δ تا خطای تحلیل

 مسیرهای   دقیق،  جداول  ارائه  با  مجموعه  این.  دهندمی  رخ  استاندارد  و  منظم  کنترل  ساختار  یک  نبود  از  ناشی  صرفاً  بلکه  فنی،  پیچیدگی  دلیل  به  نه  ،

گیری  خروجی امکان و دهدمی کاهش  توجهی قابل  شکل  به را  خطاها این  ریسک کنترلی، موارد از شدهبندی طبقه فهرستی و واضح، افزارینرم

 .سازدرا فراهم می  ایشفاف، قابل دفاع و حرفه

شود که علاوه بر ای تلقی میای زمانی حرفهاست. یک پروژه سازه  بهبود کیفیت ارائه مدارکترین اهداف این اثر،  از سوی دیگر، یکی از مهم

 خوانایی،   نظم،  نظر   ازهای اجرایی و مجموعه مستندات  ، دفترچه محاسبات، نقشهSAFE و ETABS هایمدل  شاملصحت فنی، مدارک آن  

  و   مستندسازی  سازی،مدل   برای  واحد  استاندارد  یک  تعریف  با  هالیستچکاین  .باشد  مطلوبی   سطح  در  مستندسازی  استانداردهای  و  انسجام

 .کنندمی  تبدیل ارزیابی قابل و مدون سیستم یک به و کرده خارج ایسلیقه حالت  از را  طراحی فرآیند  پروژه، تحویل

 بدیهی است قطعا موارد مهمی از کنترل ها در زمان تهیه این مجموعه از ذهن نگارنده دور مانده است .امید که با یادآوری همکاران ارجمند 

 نواقص موجود رفع گردد.
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 18 ................................................................................ (Slabs / Deck / Joist) هاسقف — 7 جدول
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 ۲1 یبارگذار جامع ستیل چک
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 Mass Source................................................................................................... ۲۴ کنترل — ۹ جدول
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 ۲5 .......................................................... (Snow — Advanced) شرفتهیپ برف یبارها — 11 جدول

 ۲5 ................................................................... (Wind — Advanced) شرفتهیپ باد بار — 1۲ جدول

 ۲5 ........................................................... (Seismic — Advanced) شرفتهیپ زلزله بار — 1۳ جدول

 ۲6 ............................................................................. (Vertical EQ) زلزله قائم یبارها — 1۴ جدول

 ۲6 ............................................. (Load Patterns QA) یبارگذار  یالگوها کامل کنترل — 15 جدول

 ۲6 ................................................................. (Slab Load QA) هادال ی بارگذار کنترل — 16 جدول
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 ۲8 ........... (Heavy Wall Load QA) هاجداکننده و نیسنگ یوارهای د ی بارگذار کنترل — ۲۲ جدول
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 81 ......................................................................... (Drawing QA) هانقشه  ت یفیک کنترل — ۹ جدول

 81 ............................................................... (Peer Review QA) همتراز ینیبازب کنترل — 1۰ جدول



 

 



 

 

 

 

 

 

 

 

 

 

 چک لیست مدل سازی سازه 
 

 

 

 

 

 

 

 

 

  



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   16

 

 ETABS در سازه  سازی مدل لیست چک  — 1       

 

 (Project Initialization) پروژه اولیه هایکنترل — ۱جدول  

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ kN–m–C Options → Units تنظیم واحدها  1

۲ Tolerance  = 1مقدار استاندارد mm Options → Tolerances ☐ 

 ☐ Edit Grid مطابق معماری Grid تعریف ۳

 ☐ Edit Story Data معماری تطابق کامل با  Story تعریف 4

 ☐ Similar Stories فقط در صورت یکنواختی  طبقات مشابه  5

 ☐ Plan View بالا  Y+راست،  X+ چرخش صحیح مدل ۶

7 Extruded View کنترل صحت مدل Display ☐ 

8 Auto Save  دقیقه  5فاصله زمانی Options ☐ 

 

 (Materials) مصالح کنترل — ۲جدول 

 چک مسیر  مقدار/معیار  کنترل لازم  مصالحنوع  ردیف 

 ☐ Define → Materials طبق نقشه  f’c بتن ۹

 ☐ — kN/m³ 24 وزن مخصوص بتن 1۰

 ☐ — ۹مبحث  /   ACI مدول الاستیسیته  بتن 11

 ☐ Modify/Show ۰.7ستون=  ۰.۳5تیر= خوردگیضرایب ترک بتن 1۲

 ☐ — طبق نقشه  Fy فولاد  1۳

 ☐ — نقشه طبق  Fu فولاد  14

 ☐ — kN/m³ 78.5 وزن مخصوص فولاد  15

 ☐ — E 200 GPa مدول فولاد  1۶

 



 ETABS    17 در سازه سازیمدل لیستچک 

 

 (Sections) مقاطع کنترل — ۳جدول  

 چک مسیر  معیار  کنترل تخصصی عضو  ردیف 

 ☐ Frame Section ۹مبحث  ابعاد مناسب  تیر بتنی  17

 ☐ Frame Section قاب خمشی ویژه  cm 4۰ ≤بعد  ستون بتنی 18

 ☐ cm ACI 318-25 Wall Sections ۲۰ ≤ضخامت  دیوار برشی 1۹

 ☐ Frame Section کنترل لاغری (IPE/HEB) نوع مناسب تیر فولادی  ۲۰

 ☐ SD 1۰مبحث  پایداری موضعی ستون فولادی  ۲1

 ☐ Local Buckling SD کنترل Section Designer مقاطع خاص  ۲۲

 

 (Beams) تیرها — ۴جدول  

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Plan View روی محور ستون قرارگیری صحیح تیر  ۲۳

۲4 End Offset  دستی برای تیرهای کناری Assign → Offset ☐ 

۲5 Frame Release  مفصل یا گیردار Assign ☐ 

 ☐ Model نباید در ستون قطع شود  عدم قطع تیر ۲۶

 ☐ Assign تقویت الزامی  تیر اطراف بازشو ۲7

 

 (Columns) هاستون — ۵جدول  

 چک مسیر  معیار  کنترل  ردیف 

 ☐ Model بدون قطع از کف تا کف  امتداد ستون  ۲8

 ☐ Extruded View زلزله   جهت  →محور قوی   گیری مقطع جهت ۲۹

 ☐ Grid Snap/Grid روی قرارگیری دقیق  ۳۰

 ☐ Analysis Settings لاغری مجاز  کنترل پایداری  ۳1

 



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   18

 

 (Shear Walls) برشی دیوار — ۶جدول 

 چک مسیر  معیار  کنترل  ردیف 

۳۲ Shell Thick رفتار Out-of-plane  کامل Draw Wall ☐ 

۳۳ Pier/Spandrel  لازم برای طراحی Assign ☐ 

۳4 Boundary Element  در فشارهای زیاد ACI   / ۹مبحث ☐ 

 ☐ Mesh ≤ 0.5 m Edit Mesh بندی مش ۳5

 ☐ Openings Assign با بازشو آسانسور  ۳۶

 

 (Slabs / Deck / Joist) هاسقف — ۷جدول  

 چک مسیر  کنترل  نوع سقف  ردیف 

 ☐ Shell Thick Draw Slab دال دوطرفه ۳7

 ☐ Membrane + Beam Assign دال یکطرفه  ۳8

۳۹ Deck  جهت صحیح ورق Deck Props ☐ 

4۰ U-Boot  دوطرفه صحیح رفتار Define ☐ 

 ☐ Model انتقال بار صحیح  پله کف راه 41

 

گم — ۸جدول    هادیافرا

 چک مسیر  معیار  کنترل  ردیف 

4۲ Rigid Diaphragm فرض حالت پیش Assign ☐ 

 ☐ Assign های پیچیده پلان صلبنیم 4۳

 ☐ Story Data نام جدا ها طبقهنیم 44

45 Rigid Zone Factor =1، فولاد=۰.5بتن Assign ☐ 

 
  



 ETABS    1۹ در سازه سازیمدل لیستچک 

 

 بازشوها — ۹جدول  

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Assign → Openings تیرگذاری مناسب  بازشو پله  4۶

 ☐ Assign کامل  Shaft بازشو آسانسور  47

 ☐ Assign انتقال بار  بازشو داکت  48

 

 مهاربندها — ۱۰جدول  

 چک مسیر  معیار  کنترل  ردیف 

 ☐ CBF / EBF Draw Frame سیستمنوع  4۹

 ☐ Assign روی گره قوی اتصال 5۰

 ☐ Model عدم برخورد  فاصله از بازشو 51

 ☐ Sections 1۰طبق مبحث   لاغری  5۲

 

 پلهراه — ۱۱جدول  

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Separate File برای حالت بحرانی  سازی جداگانه مدل  5۳

 ☐ Assign انتقال بار صحیح  طبقه تیر نیم 54

 ☐ Draw Beam سختی مناسب  ها شمشیری 55

 
  



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۲۰

 

 بندیمش — ۱۲جدول 

 چک مسیر  معیار  کنترل  ردیف 

5۶ Mesh 0.5 ≥ دال m Edit Mesh ☐ 

57 Mesh  0.3 ≥ دیوار m Edit Mesh ☐ 

58 Aspect Ratio متعادل Mesh Settings ☐ 

5۹ Transition  نرم و یکنواخت Model ☐ 

 Check Model—  ۱۳  جدول  

 چک مسیر  معیار  کنترل  ردیف 

۶۰ Duplicate Joints صفر Analyze → Check Model ☐ 

۶1 Zero Length صفر — ☐ 

۶۲ Missing Assign  کنترل کامل Report ☐ 

۶۳ Unconnected حذف کامل Model ☐ 

۶4 Mesh Errors صفر Check Model ☐ 

 

 نهایی کنترل — ۱۴جدول  

 چک توضیح کنترل  ردیف 

 ☐ کامل  Alignment راستامد بودن اعضا ۶5

 ☐ بدون چرخش ناخواسته  ستون–محور تیر ۶۶

 ☐ ها متصلهمه کف Diaphragm اتصال ۶7

 ☐ صحیح Dead Load مسیر ۶8

 

 

  



 ETABS    ۲1 در سازه سازیمدل لیستچک 

 

 

 

 

 

 

 

 

 

 

 

 

 چک لیست جامع بارگذاری
 

 

 



 

 

 سازه  بارگذاری جامع لیست چک — ۲

 

 (Dead Load) مرده بار — ۱جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ Define → Load Patterns درستی تعریف شده است به Dead Load بررسی اینکه تعریف بار مرده  1

 ☐ Assign → Shell Loads سازی، تأسیسات، اندودها( انطباق با دیتایل سقف )کف کنترل وزن سقف  ۲

 ☐ Assign → Frame/Shell Loads ۶بار خطی یا سطحی مطابق مبحث  دیوارها وزن  ۳

 ☐ — محاسبه ارتفاع × وزن مخصوص  پناه بار جان 4

 ☐ — شده پله کنترل بار تمام بار پله  5

 ☐ — کنترل وجود بارهای مضاعف  های پیرامونی بار تیرچه ۶

 

 (Live Load) زنده بار — ۲جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  کنترلمورد  ردیف 

 ☐ Define → Load Patterns ( …مطابق کاربری )مسکونی، اداری، تجاری Live Load تعریف 7

 ☐ Load Combos ۶طبق مبحث  LL اعمال بندهای کاهش کنترل کاهش سربار زنده  8

 ☐ — مقدار مطابق جدول کاربری پله بار زنده راه ۹

 ☐ — )اتاقک، خرپشته، چاهک(  ۶مطابق مبحث  زنده آسانسور بار  1۰

 

 (Snow Load) برف بار — ۳جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ Define → Load Patterns در الگوها  Snow فعال بودن بار Snow تعریف 11

 ☐ — ۶بندی مبحث پهنهمطابق نقشه  تعیین منطقه بار برف  1۲

 ☐ — دار یا اختلاف ارتفاعهای شیبدر بام Drift کنترل 1۳

 ☐ Assign اعمال صحیح بار برف موضعی بار برف خرپشته  14



 ۲۳    سازه بارگذاری جامع لیستچک 

 

 (Wind Load) باد بار — ۴جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ — ۶مطابق جدول مبحث  تعیین سرعت مبنا  15

 ☐ — با درنظرگیری ضریب اهمیت  تعیین فشار طراحی 1۶

 ☐ Define → Wind Load خودکار یا دستیباد نیمه ETABS اعمال بار باد در 17

 ☐ Assign → Loads های اصلی و باد بحرانیجهت X/Y هایاعمال جهت 18

 ☐ — کنترل بار باد منفی  اثر مکش  1۹

 

 (Earthquake Load) زلزله بار — ۵جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ — ( 14۰۳)ویرایش   ۲8۰۰از نقشه  ایتعیین پهنه لرزه ۲۰

 ☐ — مطابق گزارش مکانیک خاک  تعیین نوع خاک  ۲1

 ☐ Define → Functions → RS محاسباتی و تجربی T تعیین زمان تناوب  ۲۲

۳۳ Mass Source کنترل مشارکت LL  در جرم Define → Mass Source ☐ 

 ☐ Define → Load Patterns مطابق ضوابط  EX / EY تعریف زلزله استاتیکی ۲4

 ☐ Define → Functions → RS طیفی SPX / SPY تعریف زلزله دینامیکی ۲5

 ☐ Load Cases به برش پایه  Scale Factor مقیاس طیف  ۲۶

 

 (Temperature Load) حرارتی بارهای — ۶جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ Define → Load Patterns های با ابعاد بزرگ برای سازه Temp Load تعریف ۲7

 ☐ — طبق شرایط اقلیمی ΔT لحاظ انبساط/انقباض  ۲8

 
  



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۲۴

 

 (Special Loads) ویژه بارهای — ۷جدول 

 چک مسیر  توضیح نوع بار یف 

۲۹ Notional Load  بار جانبی فرضی فولاد Define → Load Patterns ☐ 

۳۰ Partition Load بندی معادلبار تیغه Assign → Shell Loads ☐ 

۳1 Equipment Load  بار تجهیزات سنگین — ☐ 

۳۲ Impact Load ای بار ضربه — ☐ 

 

 بارگذاری صحت کنترل — ۸جدول 

 چک مسیر  توضیح مورد کنترل ردیف 

 ☐ LL Display → Loads و DL انتقال صحیح کنترل توزیع بار  ۳۳

 ☐ Assign مطابقت بار کف با کاربری ها کنترل سقف ۳4

 ☐ — مطابقت با ضخامت و مصالح  ها کنترل بار دال ۳5

 ☐ — حذف بارهای مضاعف  کنترل بار تیرها  ۳۶

 

 Mass Source کنترل — ۹جدول 

 چک مسیر  توضیح مورد کنترل ردیف 

۳7 Mass Source  صحیح Dead   +درصدی از Live Define → Mass Source ☐ 

 ☐ Display Mass با محاسبات دستی ETABS مقایسه جرم کنترل جرم کل سازه  ۳8

 

 تحلیل برای سازیآماده — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ تأیید نهایی صحت کامل بارگذاری ۳۹

 ☐ آماده برای تحلیل  Load Cases سازیفعال 4۰

 ☐ ادامه به جلد تحلیل  سازی ترکیب بارها فعال 41



 ۲5    سازه بارگذاری جامع لیستچک 

 

 (Snow — Advanced) پیشرفته برف بارهای — ۱۱جدول 

 چک مسیر  توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ — برای شیب بام  μ اعمال ضریب بار برف شیبدار  4۲

 ☐ — اختلاف ارتفاع دو بام مجاور  (Drift) بار تجمعی 4۳

 ☐ — مطابق نقشه اقلیمی  ضریب منطقه بادگیر  44

 

 (Wind — Advanced) پیشرفته باد بار — ۱۲جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ — ۶های مبحث  طبق فرم C_p تعیین ضریب فشار 45

 ☐ Exposure Category B / C / D Define Wind تعیین 4۶

 ☐ — های بلندبرای سازه h_effective  ارتفاع مؤثر باد  47

 ☐ — ها ها، گوشهمخصوص لبه بار باد موضعی  48

 ☐ — های سبک در سقف بار مکش زیر سقف شیبدار  4۹

 

 (Seismic — Advanced) پیشرفته زلزله بار — ۱۳جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Form of Spectrum Design / User Defined Define → Functions انتخاب 5۰

 ☐ — Sa(T) وارد کردن مقادیر User Defined طیف 51

 ☐ — و اثرات آن NEHRP Class عمق مؤثر خاک 5۲

 ☐ — انتخاب صحیح براساس سیستم R ضریب 5۳

 ☐ — اهمیت سازه  I ضریب 54

 ☐ — اضافه مقاومت  Ω_0 ضریب 55

 ☐ X / Y / ±ECC Define → Load Patterns جهت اعمال زلزله  5۶

 ☐ Ritz Load Cases یا Eigen روش Modal Case انتخاب 57



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۲6

 

 ☐ Results → Modal ٪۹۰ ≤مشارکت  تعداد مودهای کافی  58

 

 (Vertical EQ) زلزله قائم بارهای — ۱۴جدول 

 چک توضیح کنترل  ردیف 

 ☐ 15m <دهانه بلند  نیاز به بار قائم 5۹

 ☐ تجهیزات سنگین  وجود بار متمرکز  ۶۰

 ☐ اجباری های با اهمیت زیاد سازه ۶1

 ☐ در طبقات نرم  اثر طبقات نامنظم ۶۲

 

 (Load Patterns QA) بارگذاری الگوهای کامل کنترل — ۱۵جدول 

 چک توضیح کنترل  ردیف 

 ☐ DL ،LL ،SL ،WL ،EQX ،EQY ،TEMP تعریف همه الگوها  ۶۳

 ☐ برای باد و زلزله  Auto Lateral کنترل ضرایب ۶4

 ☐ باشد 1باید =  Self Weight Multiplier کنترل ۶5

 ☐ kN – m کنترل واحدها  ۶۶

 

 (Slab Load QA) هادال بارگذاری کنترل — ۱۶جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Assign → Shell Load ارتفاع × وزن مخصوص = t/m بار خطی معادل دیوار ۶7

 ☐ — Partition ۳۰۰ –5۰۰ kg/m² = بندیبار تیغه ۶8

 ☐ — مطابق دیتایل اجرای معماری سازی بار کف ۶۹

 ☐ — / اینتل دک یوبوت / کوبیاکس های خاصبار دال 7۰

 
  



 ۲7    سازه بارگذاری جامع لیستچک 

 

 (Beam Load QA) تیرها بارگذاری کنترل — ۱۷جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ — سقف + تیر  عدم دوبار بارگذاری 71

 ☐ t/m Assign → Frame Load پناه بار جان 7۲

 ☐ — تیرهای اطراف نورگیر  بار پیرامونی 7۳

 

 (Stair Load) پلهراه بارگذاری — ۱۸جدول 

 چک توضیح کنترل  ردیف 

 ☐ سازی ضخامت + کف بار مرده کامل پله  74

 ☐ kg/m² 5۰۰–۳۰۰ بار زنده پله  75

 ☐ اگر پله مهاربندی دارد بارهای جانبی 7۶

 

 (MEP Loads) تجهیزات و تأسیساتی بارهای کنترل — ۱۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ وزن + فشار  بار مخزن آب  77

 ☐ بار متمرکز روی تیر  بار چیلر / بویلر  78

 ☐ توزیع مناسب  ها بار داکت 7۹

 

 (Final QA) بارگذاری نهایی کنترل — ۲۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ بررسی نهایی  ها تطابق بارگذاری با نقشه 8۰

 ☐ بندکنترل بندبه ۶تطابق با مبحث  81

 ☐ جرم صحیح  Mass بررسی ورودی 8۲

 ☐  سیستم آماده تحلیل است  8۳



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۲8

 

 (Green Roof Load QA) سبز بام بارگذاری کنترل — ۲۱جدول 

 چک  افزارمسیر نرم  توضیح تخصصی / معیار  مورد کنترل  ردیف 

 ☐ Dead Load خاک، ژئوتکستایل، لایه محافظ، زهکش  های بام سبز وزن لایه  84

 ☐ DL (Manual) 1.4تا    1.۲وزن خاک × ضریب اشباع   بار اشباع خاک  85

 ☐ Roof Garden Define → Load Patterns برای  LL = 250–300 kg/m² بار نگهداری و تردد  8۶

 ☐ Assign → Shell درصورت عدم زهکشی کافی  بار تجمعی آب باران  87

 

کننده و سنگین دیوارهای بارگذاری کنترل — ۲۲جدول    (Heavy Wall Load QA) هاجدا

 چک  افزارمسیر نرم  توضیح تخصصی / معیار  مورد کنترل  ردیف 

 ☐ Assign → Shell/Frame وزن مخصوص × ضخامت × ارتفاع  بار دیوار سنگین  8۹

 ☐ 4m Assign → Frame Load– ۲٫5برای دیوارهای   t/m بار خطی دیوارهای بلند  ۹۰

 ☐ Dead Load اعمال بار معادل صحیح  AAC/3D Panel دیوارهای  ۹1

 ☐ — روی تیرها  Out-of-Plane کنترل اثر  دیوارهای خارجی سنگین  ۹۲

 ☐ kg/m² Partition Load 5۰۰– ۳۰۰بار   های حمام و آشپزخانه تیغه  ۹۳

 

 (Special Occupancy Loads) ویژه هایکاربری بارگذاری کنترل — ۲۳جدول 

 چک  افزارمسیر نرم  توضیح تخصصی / معیار  مورد کنترل  ردیف 

 ☐ Raised Floor LL or Equipment + تجهیزات سنگین  بار کاربری اتاق سرور  ۹4

 ☐ Live Load ۶طبق مبحث   kg/m² 1۰۰۰–5۰۰ بار سالن اجتماعات  ۹5

 ☐ LL (High Density) بسته به طبقه  kg/m² 1۲۰۰–۶۰۰ بار بایگانی اسناد  ۹۶

 ☐ kg/m² LL 1۰۰۰  ≤ بار زنده   کاربری صنعتی سبک  ۹7

 ☐ kg/m² LL 7۰۰–5۰۰ کاربری ورزشی  ۹8

 



 ۲۹    سازه بارگذاری جامع لیستچک 

 

 

 

 

 

 

 

 

 

 چک لیست  جامع تحلیل سازه
 



 

 

 سازه تحلیل جامع لیست چک — ۳

 

 (Analysis Setup) تحلیل اولیه تنظیمات — ۱جدول 

 چک افزار مسیر نرم توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ Linear Static / Modal / Response Spectrum Define → Load Cases انتخاب نوع تحلیل  1

 ☐ Options → Units باشد kN–m باید واحدهای تحلیل  ۲

۳ Verify Model  قبل از تحلیل الزامی است Analyze → Check Model ☐ 

 ☐ Analyze → Set Options کافی Iteration تعداد تنظیمات همگرایی 4

 

 (Static Analysis) استاتیکی تحلیل — ۲جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ DEAD, LIVE, WIND, EQSTATIC Load Cases استاتیکی Load Case بودنفعال 5

 ☐ Define → Load Combinations ۹/1۰مطابق مبحث  ULS ترکیب بارهای ۶

 ☐ Display → Deformed Shape سختی کافی برای تحلیل  کنترل سختی سازه  7

 

 (Modal Analysis) مودال تحلیل — ۳جدول 

 چک مسیر  توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ Modal Case Eigen / Ritz Load Cases انتخاب 8

 ☐ Display → Modal Shapes ٪۹۰ ≤مشارکت جرمی  تعداد مودهای کافی  ۹

 ☐ Results مودهای پایین باید خمشی باشند ترتیب مودها  1۰

 ☐ Display Modal مودهای پیچشی ناگهانی = خطا  بررسی مودهای غیرمنطقی 11

 
  



 ۳1    سازه تحلیل جامع لیستچک 

 

 (Mass Participation) جرمی مشارکت — ۴جدول 

 چک مسیر  معیار  کنترل  ردیف 

 ☐ Y Display → Modal و X در ٪۹۰ ≤ مشارکت جرمی مجموع 1۲

 ☐ Results مود اول نباید خیلی کوچک باشد مشارکت مود اول 1۳

14 Mass Source  صحیح Dead    +درصدی از Live Define → Mass Source ☐ 

 

 (Response Spectrum Analysis) طیفی تحلیل — ۵جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ Define → Functions 14۰۳–۲8۰۰مطابق  Sa(T) تعریف طیف صحیح  15

 ☐ Load Case → Response Spectrum سازی برش پایه همپایه Scale Factor اعمال 1۶

 ☐ CQC / SRSS Load Case → Modal Combination ترکیب مودها  17

 ☐ SPX / SPY Load Patterns ها اعمال جهت 18

 

 (Base Shear Matching) پایه برش سازیهمپایه کنترل — ۶جدول 

 چک مسیر  معیار  کنترل  ردیف 

 ☐ SP ≥ ۰.8 EQSTATIC Results → Base Reaction مقایسه برش طیفی با استاتیکی  1۹

۲۰ Scale  افزار صورت دستی یا نرمبه دقیق RS Case → Scale Factor ☐ 

 ☐ Base Shear Table جدا بررسی شوند  Y و X های مختلف جهت ۲1

 

 P–Δ (P-Delta Analysis) تحلیل — ۷جدول 

 چک مسیر  توضیح کنترل  ردیف 

 ☐ P–Δ Nonlinear P-Delta Load Cases سازیفعال ۲۲

 ☐ Results حد مجاز  ≥ Stability Index θ کنترل ۲۳

 ☐ Story Stiffness طبقه نرم ممنوع  کنترل سختی طبقات ۲4



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۳۲

 

 (Irregularities) هانامنظم  کنترل — ۸جدول 

 چک ای نامهمعیار آیین کنترل  ردیف 

 ☐ نامنظمی  = TIR ≥ 1.۲ نامنظمی پیچشی  ۲5

 ☐ ٪۲۰ <تفاوت جرم طبقات  نامنظمی جرمی  ۲۶

 ☐ تغییر ناگهانی ابعاد  نامنظمی هندسی  ۲7

 ☐ بالا طبقه ٪ 7۰ ≥طبقه  K طبقه نرم  ۲8

 ☐ بالا طبقه ٪ ۶۰ ≥طبقه  K طبقه بسیار نرم  ۲۹

 

 (Drift Control) هاتغییرمکان کنترل — ۹جدول 

 چک مسیر  معیار  کنترل  ردیف 

۳۰ Drift ۰.۰۲5 ≥ طبقه میان h )۲8۰۰–14۰۳ ) Display → Drift ☐ 

۳1 Drift کنترل برای طبقات حساس  موضعی Display → Story Response ☐ 

۳۲ Drift جهت X/Y جداگانه بررسی شود Story Drift ☐ 

 

 (Forces & Stresses) هاتنش و نیروها کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ توزیع صحیح باشد  طبقات کنترل برش  ۳۳

 ☐ رفتار منطقی تیر/ستون کنترل لنگرها  ۳4

 ☐ های بحرانیستون کنترل نیروهای محوری  ۳5

 ☐ اسپندریل و مرز دیوار  کنترل تیرهای مرزی  ۳۶

 
  



 ۳۳    سازه تحلیل جامع لیستچک 

 

 (Overturning) واژگونی کنترل — ۱۱جدول 

 چک معیار  کنترل  ردیف 

 ☐ M_resist ≥ 1.۳ M_over نسبت پایداری ۳7

 ☐ تنش کششی ممنوع uplift کنترل ۳8

 (Tall Buildings) بلند هایسازه کنترل — ۱۲جدول 

 چک معیار  کنترل  ردیف 

 ☐ تجمعی  Drift تغییرمکان طبقات بالا  ۳۹

 ☐ مقایسه تجربی و تحلیلی  زمان تناوب سازه  4۰

 ☐ بررسی ویژه  مودهای پیچشی 41

 

 (Load Combinations) ترکیبی تحلیل — ۱۳جدول 

 چک توضیح کنترل  ردیف 

 ☐ ULS / SLS ترکیب حالات استاتیکی  4۲

 ☐ X/Y ترکیب زلزله 1۰۰–۳۰ 4۳

 ☐ EQz ترکیب زلزله قائم 44

 

 (Final QA) تحلیل نهایی کنترل — ۱۴جدول 

 چک توضیح کنترل  ردیف 

 ☐ تایید نهایی  صحت کامل تحلیل  45

 
  



 ولادی ف چک لیست مدل سازی ، طراحی و کنترل سازه های بتنی و   ۳۴

 

کاندرکنش  کنترل — ۱۵دول ج  (Soil–Structure Interaction) سازه– خا

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ مناسب مطابق گزارش ژئوتکنیک k_s استفاده از سازی فنر بستر مدل  4۶

 ☐ بررسی تغییر سختی در تحلیل دینامیکی پذیری پی اثر انعطاف 47

 ☐ ها پایهکنترل سختی مؤثر  در فونداسیون  P–Δ اثرات 48

 ☐ شود توصیه می 5۰m <های برای ساختمان های بلند برای سازه SSI تحلیل 4۹

 ☐ منطبق باشد SAFE سختی فنرها باید با SAFE هماهنگی با 5۰

 

 (Torsional Behavior & Interaction) پیچشی رفتار و ترکیبی مودهای  تحلیل  — ۱۶جدول 

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ مودهای پیچشی نباید جزو مودهای اولیه باشند نسبت مود پیچشی 51

 ☐ بررسی توزیع سختی در پلان و ارتفاع تمرکز سختی و جرم  5۲

 ☐ دقت بررسی شودهای نامنظم بهدر سازه (Complex Modes) مودهای ترکیبی 5۳

 ☐ طبقات حساس  TIR کنترل جابجایی پیچشی طبقات  54

 ☐ لازم است  Semi-Rigid تحلیل با صلبپیچشی ناشی از دیافراگم نیمهرفتار  55

 

 (Lateral Stability Control) سازه جانبی پایداری کنترل — ۱۷جدول  

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ سختی قاب خمشی و دیوارها باید متعادل باشد های باربر نسبت سختی سیستم 5۶

 ☐ های بلند بررسی شودچرخش پایه در سازه Base Rotation کنترل 57

 ☐ تجمعی از پایه تا بام  drift کلی ساختمان  Drift کنترل 58

 ☐ تغییر شدید سختی بین طبقات ممنوع نسبت سختی طبقات  5۹

 ☐ ۲8۰۰کنترل مرز پایداری طبق  Stability Limit کنترل ۶۰

  



 ۳5    سازه تحلیل جامع لیستچک 

 

 

 

 

 

 

 

 چک لیست جامع طراحی سازه های بتنی
 

 

  



 ولادی ف و   وکنترل سازه های بتنی   چک لیست مدل سازی،طراحی    ۳6

 

 آرمهبتن هایسازه طراحی جامع لیست چک — ۴

 

 بتن طراحی ضرایب و مصالح کنترل — ۱جدول 

 چک اینامهمرجع آیین توضیح تخصصی / معیار  مورد کنترل ردیف 

1 f’c  انطباق با نقشه و دفترچه  بتن ACI 19.2 ☐ 

۲ Fy  5۰۰یا  4۰۰ فولاد MPa  مطابق نقشه ASTM A615 ☐ 

 ☐ E 4700√f’c (MPa) ACI 19.2.2 مدول الاستیسیته ۳

 ☐ ۶مبحث  kN/m³ 24 وزن مخصوص بتن 4

 ☐ ACI Table 6.6.3.1.1   ۰.۲5=دال ۰.7=ستون ۰.۳5=تیر خوردگیضرایب ترک 5

 ☐  ACI 21.2 ۰.75/ برشی=  ۰.۹خمشی= ϕ ضرایب مقاومت ۶

 

 (Flexure & Shear) آرمهبتن تیرهای طراحی — ۲جدول 

 چک مرجع  توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ ۹مبحث  و ارتفاع مناسب  ۲5حداقل عرض  ابعاد تیر  7

 ☐ Mn ≥ Mu/ϕ ACI 22.2 محاسبه ظرفیت خمشی 8

 ☐ As_min ρ_min = 0.25√f’c / fy ACI 9.6.1 کنترل ۹

 ☐ As_max ρ_max ≤ ۰.75ρ_bal ACI 22.3 کنترل 1۰

 ☐ Vn ≥ Vu/ϕ ACI 22.5 کنترل برش 11

 ☐ S ≤ min) 0.75d   ،۳۰۰mm ) ACI 25.7 ها خاموت 1۲

 ☐ ld = (fy λ) / (1.25√f’c) ACI 25.4 طول مهاری  1۳

 ☐ T_u ACI 22.7 بررسی پیچش )در صورت نیاز(  14

 
  



 ۳7            آرمه بتن  هایسازه  طراحی جامع لیستچک  

 

 (Axial + Flexure) هاستون طراحی — ۳جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ ۹مبحث  در قاب خمشی 4۰cmحداقل  ابعاد ستون 15

 ☐ Pu ≤ φPn ACI 22.4 نسبت بار محوری 1۶

 ☐ ρ ≤ ۶٪ ACI 22.4.3 ≥ ٪1 نسبت آرماتور طولی 17

 ☐ Interaction Diagram ACI Appendix کنترل نمودار اندرکنش  18

 ☐ db ACI 25.7 16یا  S ≤ 150mm خاموت ستون 1۹

 ☐ Ld/Lap ACI 25.5 ها طول مهاری وصله  ۲۰

 

 (Shear Wall Design) برشی دیوارهای طراحی — ۴جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ ۹مبحث  ۲۰cm ≤ ضخامت دیوار  ۲1

 ☐ Vn ≥ Vu/ϕ ACI 22.5 کنترل برش ۲۲

۲۳ Boundary Elements الزام در تنش بالا ACI 18.10 ☐ 

 ☐ ρh ≥ 0.0025 ACI 11.6 فولاد افقی ۲4

 ☐ ρv ≥ 0.0025 ACI 11.6 فولاد قائم ۲5

 ☐ — برای افزایش ظرفیت  P نیروی محوری ۲۶

 ☐ ACI 18.10.6 ها فاصله خاموت کمانش میلگردها  ۲7

 
  



 ولادی ف و   وکنترل سازه های بتنی   چک لیست مدل سازی،طراحی    ۳8

 

 (Slabs) هادال طراحی — ۵جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ ۹مبحث  15cm–1۲حداقل  ضخامت دال ۲8

 ☐ ρ_shrink ≥ 0.0018 ACI 7.5 حداقل فولاد حرارتی  ۲۹

 ☐ ACI 24 طراحی وسط دهانه  خمش مثبت  ۳۰

 ☐ — گاه طراحی تکیه خمش منفی  ۳1

 ☐ Vu ≤ φVn ACI 22.5 برش یکطرفه  ۳۲

 ☐ ACI 22.6 ها ستونکنترل در  برش پانچ ۳۳

 

 SAFE (Punching – SAFE) در پانچ برش کنترل — ۶جدول 

 چک SAFE مسیر توضیح کنترل  ردیف 

 ☐ Display → Punching ها برش پانچ در ستون Vu کنترل ۳4

۳5 Vc  مطابق ظرفیت بتن ACI Punching Shear Output ☐ 

 ☐ — ضخامت آرماتور برشی یا افزایش  نیاز به تقویت  ۳۶

 ☐ — 4d ≤ کنترل فاصله ستون تا لبه دال  ۳7

 

 (Deflection) خیز کنترل — ۷جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ ۹مبحث  Δ ≤ L/240 خیز آنی ۳8

 ☐ Δ_total ≤ L/180 ACI 24.2 خیز بلندمدت ۳۹

 ☐ ACI 24.2 صحیح باشد I_eff خوردگیضرایب ترک 4۰

 
  



 ۳۹            آرمه بتن  هایسازه  طراحی جامع لیستچک  

 

 ایلرزه نامهآیین بتن، پوشش ها،وصله کنترل — ۸جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ 25–40mm ACI 20.6 (Cover) پوشش بتن 41

 ☐ fy ACI 25.5 بر اساس L_lap های پوششیوصله 4۲

 ☐ ACI 25.3 °1۳5یا   °۹۰ قلاب انتهایی 4۳

 ☐ ACI 18.7 میلگردگذاری ویژه  SMF ایالزامات ویژه لرزه 44

 ☐ ۳d ACI 25.2یا  S ≤ ۳۶cm کنترل فواصل میلگرد  45

 

 بتن طراحی نهایی کنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ عدم تراکم غیرمجاز  کنترل تناسب آرماتورگذاری 4۶

 ☐ ای رعایت ضوابط لرزه پذیریکنترل شکل 47

 ☐ همخوانی  با محاسبات دستی  ETABS/SAFE انطباق خروجی 48

 

 (Special Moment Frame Beams) ویژه خمشیهای قاب در تیرها — ۱۰جدول 

 چک مرجع  توضیح کنترل  ردیف 

قاب   5۰ در  تیر  ابعاد  حداقل 

 خمشی

 /ACI 318 / ۹مبحث  های ویژه کنترل عرض و ارتفاع کافی در قاب

(Seismic) 

☐ 

ویژه خمشی در در دو طرف ستون، ناحیه   h 2حداقل به طول طول ناحیه بحرانی 51

 نظر گرفته شود

 ☐ ACI ایضوابط لرزه

ناحیه   5۲ در  ویژه  خاموت 

 بحرانی 

 ≥ S مثلاً( ها در ناحیه بحرانی کاهش یابدخاموت S فاصله

d/4 ) 

ضوابط قاب خمشی 

 ویژه 

☐ 

های پوششی میلگردهای طولی خارج از ناحیه بحرانی وصله های طولیوصله 5۳

 اجرا شوند

ACI – Splice 

Detailing 
☐ 



 ولادی ف و   وکنترل سازه های بتنی   چک لیست مدل سازی،طراحی    ۴۰

 

 (Special Moment Frame Columns) های خمشی ویژهها در قابستون — ۱۱جدول 

 چک  مرجع توضیح  کنترل ردیف 

 ☐ ای/ ضوابط لرزه  ۹مبحث  ) کنترل بعد حداقل ستون در قاب خمشی ویژه حداقل بعد ستون 55

قوی   5۶ ستون   تیر  –نسبت 

 ضعیف 

ستون خمشی  ظرفیت  گره  مجموع  در  مجموع  1.۲ <ها 

 ظرفیت تیرها باشد 

Strong Column–

Weak Beam 
☐ 

 ☐ ACI – Confinement بحرانی   ناحیه در 1۳5 °استفاده از خاموت بسته و قلاب آرماتور محصورشدگی 57

 ☐ ای ستون ضوابط لرزه شودبالاو پایین ستون که خاموت ویژه الزامی است تعریف  طول ناحیه ویژه ستون  58

 ☐ ACI – Lap Splice ها در ناحیه غیر بحرانی و با طول پوشش کافی  محل وصله وصله آرماتور طولی 5۹

 ☐ ACI 318 – Columns ( ٪۶ حدود تا  ٪1ستون ) ρmax و ρmin کنترل نسبت آرماتور طولی ۶۰

 

 (Beam–Column Joint Detailing) ستون–تیرگره  — ۱۲جدول 

 چک مرجع  توضیح کنترل  ردیف 

تیر آرماتور عرضی در گره  ۶1 اتصال  ناحیه  در  بسته  یا حلقه  – تأمین خاموت 

 ستون

ACI – Joint Detailing ☐ 

از  ۶۲ تیر  طولی  میلگردهای  عبور 

 گره 

 ☐ ACI   / های اجرایینقشه کنترل طول عبور و قلاب در داخل گره ستون 

 ☐ تحلیل / طراحی مقطع در گره و در صورت نیاز تقویت آنبررسی برش  برش گره ۶۳

 ☐ کنترل اجرایی اجراکنترل امکان اجرا و عدم تراکم غیرقابل ازدحام آرماتور در گره  ۶4

با   ETABS/SAFE مقایسه  ها با نتایج طراحی تطبیق آرماتور گره در نقشه سازگاری مدل و نقشه ۶5

 نقشه 

☐ 

 
  



 

 

 

 

 

 

 

 

 

 فولادیچک لیست جامع طراحی  سازه های 
 



 

 

 فولادی هایسازه طراحی جامع لیست چک — 5

 

 فولاد مشخصات و مصالح کنترل — ۱جدول 

 چک مرجع  توضیح تخصصی / معیار  مورد کنترل ردیف 

1 Fy  فولاد ST37 = 240 MPa ،ST52 = 345 MPa  1۰مبحث ☐ 

۲ Fu  فولاد Fu ≥ 1.5Fy  1۰مبحث ☐ 

 ☐ E = 200 GPa AISC مدول الاستیسیته  ۳

 ☐ — جوشی / مرکب نورد شده /  بررسی نوع پروفیل  4

 

 (Tension Members) کششی اعضای طراحی — ۲جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ Pn = AgFy AISC مقاومت کششی اسمی  5

 ☐ Pn = AeFu AISC کنترل گسیختگی  ۶

 ☐ Interaction AISC کشش ترکیبی -بررسی خمش 7

 

 (Compression Members) فشاری اعضای طراحی — ۳جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ 1۰مبحث  حد مجاز  ≥ KL/r لاغری ستون 8

 ☐ Pn = Fcr × Ag AISC مقاومت فشاری ۹

 ☐ AISC حول هر دو محور کنترل کمانش خمشی  1۰

 ☐ AISC برای مقاطع باز  جانبی-کنترل کمانش پیچشی 11

 
  



 ۴۳               فولادی هایسازه  طراحی جامع لیستچک 

 

 (Beams) فولادی تیرهای طراحی — ۴جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ Mn ≥ Mu/ϕ AISC F2 طراحی خمشی  1۲

 ☐ Vn ≥ Vu/ϕ AISC G2 کنترل برش 1۳

 ☐ 1۰مبحث  Δ ≤ L/240 خیز تیر  14

 ☐ Lp  ،Lr AISC F3 بررسی (LTB) پیچشی-کمانش جانبی 15

 ☐ λ ≤ λr AISC B4 کنترل پهنای بال 1۶

 

 (Composite Beams) کامپوزیت تیرهای — ۵جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ AISC I8 مطابق ظرفیت برشی  تعداد برشگیرها  17

 ☐ Mn_comp ≥ Mu AISC ظرفیت خمشی مرکب  18

 ☐ ۹مبحث  8cm ≤ حداقل ضخامت دال  1۹

 

 (Bracing) مهاربندها طراحی — ۶جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ 1۰مبحث  CBF / EBF مهاربندنوع  ۲۰

 ☐ Tn = AgFy AISC ظرفیت کششی  ۲1

 ☐ Pn = FcrAg AISC ظرفیت فشاری  ۲۲

 ☐ — نسبت طول به ارتفاع  کنترل دهانه مهاربند  ۲۳

 ☐ 1۰مبحث  ای ضوابط ویژه قاب لرزه مفصل همگرا/واگرا ۲4

 
  



 ولادی ف و  وکنترل سازه های بتنی  چک لیست مدل سازی،طراحی             ۴۴

 

 (Connections) اتصالات طراحی — ۷جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ AISC J1 های تقویتیصفحه انتهایی/بال ستون -اتصال گیردار تیر ۲5

 ☐ AISC J2 بالشتکی یا نبشی جان  اتصال ساده ۲۶

 ☐ ASTM A325/A490 تنش برشی و کششی ها کنترل پیچ ۲7

 ☐ AWS D1.1 طول مؤثر، ضخامت ها کنترل جوش ۲8

 ☐ — موضعیکنترل کمانش  های تقویتیورق ۲۹

 

 (Base Plates) ستون صفحه طراحی — ۸جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ 7مبحث  q ≤ q_allow تنش زیر صفحه  ۳۰

 ☐ AISC کنترل خمش  ضخامت صفحه  ۳1

 ☐ — انطباق با ابعاد ستون  طول و عرض صفحه  ۳۲

 ☐ ASTM F1554 تنش کششی و برشی انکر بولت  ۳۳

 

 تقویتی اجزای و هاورق کنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ کنترل کمانش  ورق جان ۳4

 ☐ افزایش مقاومت خمشی  ورق روسری / زیرسری ۳5

 ☐ تقویت ناحیه اتصال doubler ورق ۳۶

 
  



 ۴5               فولادی هایسازه  طراحی جامع لیستچک 

 

 فولاد طراحی نهایی کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ ای ضوابط لرزه 1۰انطباق با مبحث   ۳7

 ☐ همخوانی  با محاسبات دستی ETABS تطبیق نتایج ۳8

 ☐ صفحه ستون، جوش، پیچ کنترل نهایی اتصالات ۳۹

 (Steel SMF Detailing) فولادی ویژه خمشی قاب در هاستون و تیرها — ۱۱جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐  /AISC  1۰مبحث  پذیرینسبت دهانه، محدودیت مقطع لاغر، و تأمین شکل خمشی ویژه ضوابط تیر در قاب  41

 ☐  AISC Seismic در هر گره  M_column ≥ 1.2 × ∑M_beam∑ ضعیف  تیر –ستون قوی  4۲

 ☐ خمشی اتصالات ایطول ناحیه تسلیم در نزدیکی ستون مطابق دیتیل لرزه (Fuse Region) ناحیه تسلیم تیر 4۳

 ☐  AISC مجاز در تیرهای قاب خمشی V_u ≤ V_max کنترل محدودیت برش در ناحیه مفصل   44

 ☐ AISC–Stiffeners برای جلوگیری از کمانش جان   stiffener استفاده از های جان  کنندهسخت 45

 

 (Local Buckling of Plate Elements) مقطع اجزای موضعی کمانش کنترل — ۱۲جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ AISC Table B4.1 فشرده / لاغر مقایسه با حدود مقطع فشرده / نیمه (b_f/t_f) نسبت پهنای بال به ضخامت 4۶

 ☐ AISC B4 کنترل عدم لاغری بیش از حد جان در تیر و ستون  (h/t_w) نسبت ارتفاع جان به ضخامت 47

 ☐ AISC Chapter E/F اعمال ضرایب کاهش مقاومت برای اعضای لاغر کنترل مقاطع لاغر  48

 ☐ جزئیات اجرایی کنترل انتقال تنش مناسب بین پروفیل و ورق   های تقویتی جوشیورق 4۹

 ☐ طراحی پیشرفته مقاطع  ارزیابی کمانش موضعی تحت خمش + فشار  پایداری مقطع تحت فشار ترکیبی 5۰

 
  



 ولادی ف و  وکنترل سازه های بتنی  چک لیست مدل سازی،طراحی             ۴6

 

 (Composite Beams with Metal Deck) فلزی عرشه باکامپوزیت  تیرهای — ۱۳جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ دیتایل سقف عرشه فولادی های عرشه بر تیر اصلی اطمینان از عمود بودن تیرچه جهت قرارگیری عرشه   51

 ☐ راهنمای سقف مرکب AISC بر اساس مقاومت برشی و حداقل فواصل مجاز  کنترل  گیرها فواصل برش 5۲

 ☐ / سقف عرشه ۹مبحث  ( 8cm ≤معمولاً ( حداقل موردنیاز ≤ h_slab ضخامت بتن روی عرشه  5۳

 ☐ shear studs AISC Composite Design بررسی لغزش احتمالی و کفایت تعداد دال–کنترل برش طولی تیر 54

 ☐ / ۹Serviceabilityمبحث  برداری و خزشتحت بار بهره Deflection کنترل بلندمدت تیر کامپوزیت خیز   55

 

 (Seismic Braced Frames QA) ایلرزهمهاربندی  رفتار کنترل — ۱۴جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ ۲8۰۰/ 1۰مبحث  و ضوابط  R بر اساس ضریب CB  ،SCBF  ،BRBF  ،EBF انتخاب نوع سیستم مهاربندی 5۶

 ☐ /AISC 1۰مبحث  در محدوده مجاز برای عملکرد کششی/فشاری   KL/r طول مهاربند و نسبت لاغری  57

 ☐ AISC Seismic کنترل ظرفیت تحت بارگذاری معکوس  طراحی مهاربند رفت و برگشتی  58

 ☐ ConnectionDesign کفایت ضخامت و جوش/پیچ در محل اتصال  اتصال مهاربند به گاست پلیت  5۹

 ☐  /AISC 1۰مبحث  EBF طول لینک، برش و خمش لینک مطابق ضوابط ویژه  کنترل مفصل همگرا / واگرا  ۶۰

 



 

 

 

 

 

 

 

 

 

 چک لیست جامع طراحی فونداسیون 
 



 

 

 SAFE و فونداسیون طراحی جامع لیست چک — 6

 

 SAFE (Project Setup) پروژه اولیه کنترل — ۱جدول 

 چک افزار نرممسیر  توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ Options → Units باشد  kN–m–C باید SAFE واحدهای پروژه 1

 ☐ ETABS Plan View منطبق با Level و Grid تعریف ۲

 ☐ File → Import ETABS ترکیب بار صحیح  Reaction ETABS وارد کردن ۳

4 Thickness Units mm انتخاب شود Options ☐ 

 

ک مشخصات کنترل — ۲جدول   (Soil Properties) خا

 چک مرجع  توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ ژئوتکنیک  مطابق گزارش مکانیک خاک  q_all باربری مجاز خاک 5

 ☐ 7مبحث  برای پی سطحی FS ≥ 3  ضریب اطمینان  ۶

 ☐ ژئوتکنیک  شده در گزارشتعیین k_s مدول واکنش خاک 7

 ☐ — بر ظرفیت اثر  سطح آب زیرزمینی 8

 

 (Slab Modeling) فونداسیون دال سازیمدل — ۳جدول 

 چک مسیر  معیار  کنترل  ردیف 

 ☐ 5۰cm Define Slab–۳۰حداقل  ضخامت فونداسیون ۹

 ☐ Draw Slab برای فونداسیون  Shell Thick نوع 1۰

11 Mesh  ۰.5حداقل  مناسبm Mesh Options ☐ 

 ☐ Pier/Base Assign Assign فونداسیون اتصال دیوارها به   1۲

 
  



 ۴۹               فونداسیون طراحی جامع لیستچک 

 

 (Isolated Footing) منفرد پی طراحی — ۴جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ 7مبحث  A ≥ P/q_all ابعاد پی 1۳

 ☐ q_max ≤ q_all SAFE Reaction تنش یکنواخت زیر پی 14

 ☐ Vu ≤ φVn ACI 22.5 برش یکطرفه  15

 ☐ Punching Shear ستون مرکزیکنترل در  برش پانچ 1۶

 ☐ ACI 7.6 رعایت شود As_min حداقل آرماتورگذاری 17

 

 (Strip Footing) نواری پی طراحی — ۵جدول 

 چک مسیر  معیار  کنترل  ردیف 

 ☐ 7مبحث  b ≥ Pu/(q_all·L) عرض نوار  18

 ☐ Mn ≥ Mu/ϕ ACI 22.2 مقاومت خمشی  1۹

 ☐ Vu ≤ φVn ACI 22.5 برش یکطرفه  ۲۰

 ☐ ۹مبحث  Δ ≤ L/250 کنترل خیز  ۲1

 

 (Raft Foundation) گسترده فونداسیون طراحی — ۶جدول 

 چک توضیح کنترل  ردیف 

 ☐ مناسب برای توزیع بار  سختی دال ۲۲

 ☐ q_all مطابق تنش زیر دال ۲۳

۲4 Punching بررسی کامل  ها در ستون ☐ 

 ☐ تقویتیشبکه  آرماتورگذاری بالا/پایین  ۲5

 ☐ مدت/بلندمدتبررسی کوتاه کنترل نشست  ۲۶

 
  



 ولادی ف و  وکنترل سازه های بتنی  چک لیست مدل سازی،طراحی             5۰

 

 (Pile Design) شمع گروه و شمع طراحی — ۷جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ ژئوتکنیک  Qa ≥ P_u ظرفیت باربری شمع  ۲7

 ☐ 7مبحث  اثر کاهش گروهی گروه شمع  ۲8

 ☐ SAFE Punching کنترل برش پانچ  تنش سربار  ۲۹

 ☐ ژئوتکنیک  براساس عمق لایه مقاوم  طول شمع ۳۰

 

Structural) فونداسیون دال ایسازه کنترل — ۸جدول   Design) 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ Mn ≥ Mu/ϕ ACI 22.2 طراحی خمشی  ۳1

 ☐ Vu ≤ φVn ACI 22.5 طراحی برشی  ۳۲

 ☐ ρ_min ACI 7.6 رعایت آرماتور حداقل  ۳۳

 ☐ Shrinkage Steel ACI 7.5 دماییآرماتور  ۳4

 

 (Settlement & Stability) پایداری و نشست کنترل — ۹جدول 

 چک مرجع  معیار  کنترل  ردیف 

 ☐ ژئوتکنیک  S ≤ 25–50mm نشست کل مجاز  ۳5

 ☐ 7مبحث  ΔS ≤ 20mm اختلاف نشست  ۳۶

۳7 uplift  جلوگیری از کشش خاک SAFE Reaction ☐ 

 

 (Final QA) فونداسیون نهایی کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ کنترل کامل  7انطباق با مبحث   ۳8

 ☐ صحت طراحی  ACI/SAFE انطباق با ۳۹



 51               فونداسیون طراحی جامع لیستچک 

 

 

 

 

 

 

 

  چک لیست کنترلهای معماری مرتبط با سازه
 



 

 

 سازه  با مرتبط معماری هایکنترل لیست چک — 7

 

 معماری پلان با هماهنگی و هاستون جانمایی کنترل — ۱جدول 

 چک مرجع/مسیر  توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ ETABS / معماری دقیقاً زیر دیوار اصلی قرار گیرد ستون باید  اصلیستون زیر دیوارهای  1

 ☐ پلان معماری  مترسانتی 5عدم اختلاف محور بیش از  ها با محور معماری تراز بودن محور ستون ۲

 ☐ نقشه نما  تداخل با شیشه و پوسته نما ممنوع  های نمای حساس ستون در لبه ۳

 ☐ معماری  ممنوع بدون دلیل فنی ۲m ≤بازشو  عدم قرارگیری ستون وسط بازشوهای بزرگ 4

 

 (Elevator Shaft Beams) آسانسور اطراف تیرهای کنترل — ۲جدول 

 چک مسیر/مرجع  توضیح تخصصی  کنترل  ردیف 

 ☐ Plan/ETABS چهارچوب شفت باید کامل بسته باشد گذاری کامل اطراف شفت تیرک 5

 ☐ معماری/سازه  سختی کافی برای انتقال بار  برقی/آسانسور تیر مضاعف در طرفین راه پله  ۶

 ☐ پلان طبقات  همراستایی با سازه زیرزمین  کنترل محل چاهک آسانسور  7

 ☐ معماری  هماهنگی با سازه و موتورخانه  کنترل ارتفاع شفت  8

 

 (Stairs) طبقهنیم و پله هایکنترل — ۳جدول 

 چک مرجع/مسیر  توضیح موارد کنترل  ردیف 

 ☐ ETABS تأمین قاب کامل اطراف پله  تیرهای دور بازشو پله  ۹

 ☐ معماری/سازه  انتقال صحیح بار به تیر اصلی  تخلیه بار از شمشیری پله  1۰

 ☐ معماری  نیاز به طراحی ویژه  پله شناور یا معلق  11

 ☐ ETABS Assign Diaphragm ایجاد دیافراگم جداگانه در اختلاف تراز کف پله با دال  1۲

 
  



 5۳               سازه با مرتبط  معماری هایکنترل لیستچک 

 

 سازه با معماری دیوارهای هماهنگی — ۴جدول 

 چک مرجع  توضیح تخصصی  کنترل  ردیف 

 ☐ ۶مبحث  بار معادل تیغه محاسبه شود دیوار روی دال 1۳

 ☐ سازه  ممنوع مگر با تقویت تیرچه  دیوار روی تیرچه  14

 ☐ ETABS Shell بررسی شود  Out-of-plane نیروهای دیوارهای سرتاسری  15

 ☐ معماری  عدم ایجاد بار جانبی اضافی دیوارهای سبز/تزئینی 1۶

 

 (Facade Coordination) ساختمان نمای با مرتبط هایکنترل — ۵جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ نقشه نما  نما جلوگیری از تداخل با فریم  والعدم قرارگیری تیر در مسیر کرتین 17

 ☐ ۶مبحث  انتقال بار به سازه اصلی  کنترل بارهای باد روی نما 18

 ☐ Dead Load اعمال شود  ETABS بار مرده نما در کنترل وزن نمای سنگی 1۹

 ☐ معماری/سازه  نیاز به پلیت/انکر در سازه  کنترل دیتیل صفحه نما  ۲۰

 

 (MEP–Structural Coordination) سازه با تاسیسات هماهنگی — ۶جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ MEP/معماری عدم برخورد با تیر و ستون ها محل عبور داکت ۲1

 ☐ ETABS Opening تقویت اطراف بازشو  چاه تاسیسات  ۲۲

 ☐ بار زنده/تجهیزات  بارگذاری صحیح در سازه  وزن تجهیزات سنگین  ۲۳

 ☐ معماری  ممنوعیت عبور از دیوار برشی محل عبور رایزرها  ۲4

 
  



 ولادی ف و  وکنترل سازه های بتنی  چک لیست مدل سازی،طراحی             5۴

 

 (Ramp & Parking) پارکینگ و رمپ هماهنگی — ۷جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ معماری  مجاز  ٪1۲ شیب رمپ  ۲5

 ☐ سازه  تقویت تیرهای تحت بار  تیرهای زیر رمپ  ۲۶

 ☐ ETABS کنترل ضعف برشی بازشو رمپ در دیوار برشی ۲7

 

 ایلرزه بر مؤثر معماری هایکنترل — ۸جدول 

 چک مرجع  توضیح کنترل  ردیف 

 ☐ ۶مبحث  اعمال بار ثقلی و جانبی  های سنگین بالکن ۲8

 ☐ ۲8۰۰ نیاز به کنترل سختی  1.۲m <آمدگی نما پیش ۲۹

 ☐ ۲8۰۰ کنترل تغییر جرم  طبقات با کاربری متفاوت  ۳۰

 ☐ ۲8۰۰ احتمال ایجاد طبقه نرم  بازشوهای بزرگ در طبقه پایین  ۳1

 

 سازه–معماری نهایی هماهنگی هایکنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ ها، تیرها، بازشوها ستون هماهنگی کامل پلان سازه و معماری ۳۲

 ☐ پرهیز از تداخل  ها هماهنگی نما با ساختار قاب ۳۳

 ☐ سازگاری کامل  ها، پله، داکت کنترل نهایی شفت ۳4

 ☐ آرشیتکت + سازه  های مشترک سازی نقشهآماده ۳5

 



 

 

 

 

 

 

 

 

 

   چک لیست جامع کنترل دفترچه محاسبات
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 سازه  محاسبات دفترچه کنترل جامع لیست چک — 8

 

General) محاسبات دفترچه کلی ساختار کنترل — ۱جدول   Structure) 

 چک توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ شامل نام، محل پروژه، طراح، تاریخ  جلد و عنوان پروژه  1

 ☐ گذاری کامل و هماهنگ با متنشماره فهرست مطالب  ۲

 ☐ ها دقیق، مطابق نقشه باربر جانبی و ثقلی تعریف سیستم  ۳

 ☐ حتماً در ابتدای دفترچه  ارائه پلان معماری و سازه  4

 ☐ ذکر دقیق سال و نسخه  ها نامهمنابع و آیین 5

 

 (Load Calculation QA) دفترچه بارگذاری کنترل — ۲جدول 

 چک توضیح کنترل  ردیف 

 ☐ محاسبه وزن مصالح دقیق  بار مرده  ۶

 ☐ ۶مطابق مبحث  بار زنده  7

 ☐ بندی صحیحمنطقه بار برف 8

 ☐ تعیین سرعت، ضریب اهمیت  بار باد ۹

 ☐ تعیین پهنه، نوع خاک، طیف  بار زلزله  1۰

 

 (Analysis Section) سازه تحلیل کنترل — ۳جدول 

 چک توضیح کنترل  ردیف 

 ☐ خطی/غیرخطی توضیح روش تحلیل  11

 ☐ ٪۹۰ ≤مشارکت جرمی  کنترل مودال 1۲

 ☐ SP ≥ ۰.8 EQstatic برش سازی طیفیهمپایه 1۳

 ☐ θ سازی + کنترلفعال P–Δ کنترل 14
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 ☐ ۰.۰۲5h ≥ کنترل دریفت  15

 

 (Concrete Design QA) بتن طراحی بخش کنترل — ۴جدول 

 چک معیار  کنترل  ردیف 

 ☐ خمش، برش، پیچش  طراحی تیر  1۶

 ☐ Interaction Diagram طراحی ستون  17

 ☐ مرز فشاری، خاموت ویژه  طراحی دیوار برشی 18

 ☐ SAFE نتایج برش پانچ 1۹

 ☐ آنی + بلندمدت  کنترل خیز  ۲۰

 

 (Steel Design QA) فولاد طراحی بخش کنترل — ۵جدول 

 چک توضیح کنترل  ردیف 

 ☐ AgFy ،AeFu طراحی اعضای کششی ۲1

 ☐ لاغری، کمانش  طراحی ستون فولادی ۲۲

 ☐ LTBخمش، برش،  طراحی تیر  ۳

 ☐ کشش/فشار، مفصل همگرا/واگرا طراحی مهاربند  ۲4

 ☐ پیچ، جوش، ورق تقویتی طراحی اتصالات  ۲5

 

 SAFE و فونداسیون طراحی کنترل — ۶جدول 

 چک توضیح کنترل  ردیف 

 ☐ صحیح  q_all کنترل باربری خاک  ۲۶

 ☐ یکطرفه + پانچ برش  طراحی پی منفرد  ۲7

 ☐ خمش + برش طراحی پی نواری  ۲8

 ☐ توزیع تنش + نشست  فونداسیون گسترده  ۲۹
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 ☐ ظرفیت، گروه شمع  کنترل شمع  ۳۰

 

گرام کنترل — ۷جدول   (Charts & Outputs) هاخروجی و هادیا

 چک توضیح کنترل  ردیف 

 ☐ واضح و قابل خواندن دیاگرام نیروی محوری ۳1

 ☐ M3 ،M2 دیاگرام لنگر  ۳۲

 ☐ V2 ،V3 دیاگرام برش  ۳۳

 ☐ Drift ،Disp دیاگرام تغییرمکان  ۳4

 ☐ گذاری شوند ها شمارهشکل ها به عنوان در متن اتصال خروجی ۳5

 

 (Code Compliance) استاندارد و آیینی لحاظ از دفترچه کنترل — ۸جدول 

 چک مرجع  کنترل  ردیف 

 ☐ ۶مبحث  ۶بارگذاری با مبحث انطباق  ۳۶

 ☐ ACI ACI 318-25 طراحی بتن طبق ۳7

 ☐ 1۰مبحث  1۰طراحی فولاد طبق مبحث   ۳8

 ☐ ۲8۰۰استاندارد  ۲8۰۰ای طبق  کنترل لرزه ۳۹

 ☐ 7مبحث  کنترل خاک و پی 4۰
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 (Writing QA) دفترچه نوشتاری ساختار کنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ فارسی و صحیح  ها گذاری فرمولشماره 41

 ☐ هماهنگ و یکتا  ها گذاری شکلشماره 4۲

 ☐ kN–m ،mm استفاده از واحدهای صحیح  4۳

 ☐ ACI / AISC دهی استانداردبندهای رفرنس 44

 ☐ بین جداول و متن عدم وجود تناقض در اعداد 45

 

 (Final QA) محاسبات دفترچه نهایی کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ کنترل مقطع، میلگرد، ابعاد  ها با دفترچه تطابق نقشه 4۶

 ☐ بدون اختلاف غیرمجاز  ETABS/SAFE مطابقت خروجی 47

 ☐ بدون بخش ناقص  ها کامل بودن تمام فصل 48

 ☐ الزامی  امضای طراح و بازبین  4۹

 ☐ نسخه نهایی آماده برای تحویل 5۰

 (Model–Document Consistency) دفترچه با تحلیلی مدل همخوانی کنترل — ۱۱جدول 

 چک توضیح تخصصی / معیار مورد کنترل  ردیف

 ☐ باشد  ETABS/SAFE مقاطع تیر، ستون، دیوار و دال مطابق مدل  انطباق ابعاد اعضا 51

 ☐ موجود تطابق داشته باشد  Load Patterns بارهای واردشده در دفترچه با انطباق بارهای وارد بر سازه 5۲

 ☐ شده در تحلیل با جدول بارگذاری دفترچه یکسان باشد جرم محاسبه Mass Source انطباق 5۳

 ☐ خوردگی دفترچه یکسان باشد شده با ضرایب ترکاعمال  I_eff مقدار انطباق سختی اعضا 54
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 Boundary انطططططططبطططاق 55

Conditions 

 ☐ گاهی در مدل با نقشه و دفترچه مطابقت داشته باشد شرایط تکیه

 

 (Calculation Logic QA) طراحی روند و هافرمول ،روابط کنترل — ۱۲جدول 

 چک توضیح تخصصی / معیار کنترل  ردیف

 ☐ محاسباتی استفاده شده باشد بدون خطای تایپی یا  ACI / AISC روابط های اصلی صحت فرمول  5۶

 ☐ باشند .... حاسبات شامل معرفی پارامترها، فرمول، جایگذاری اعداد و م مرحلهبهمرحله  محاسبات 57

 ☐ استفاده شده باشد  (kN–m–mm) در کل دفترچه تنها یک سیستم واحد  یکسان بودن واحدها 58

 ☐ نتایج غیرعادی بررسی و اصلاح شده باشند  منطقی استفاده از اعداد  5۹

 



 

 

 

 

 

 

 

 

 

    چک لیست جامع کنترل نقشه های اجرائی سازه 
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 سازه اجرایی هاینقشه کنترل جامع لیست چک — ۹

 

 (General Drawing QA) هانقشه عمومی کنترل — ۱جدول 

 چک توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ تاریخ، شماره شیت، نام پروژه  عنوان و شماره نقشه  1

 ☐ 1:۲۰ / 1:1۰۰ / 1:5۰ مقیاس صحیح  ۲

 ☐ یکسان و استاندارد  کشی، ضخامت، فونت خط ۳

 ☐ صحیح و خوانا  کروکی شمال  4

 ☐ پلان معماری و سازه هماهنگ  ها عدم وجود اختلاف بین پلان 5

 

 (Beam Drawings) تیرها نقشه کنترل — ۲جدول 

 چک توضیح تخصصی  کنترل  ردیف 

 ☐ مطابق دفترچه محاسبات ابعاد تیر  ۶

 ☐ گذاری تعداد، قطر، محل میلگردهای طولی بالا/پایین  7

 ☐ ، قطر، تعداد شاخه S ها خاموت 8

 ☐ صحیح Ld طول مهاری  ۹

 ☐ محل مناسب، حداقل طول ها وصله 1۰

 ☐ تقویت لازم  کنترل تیرهای اطراف بازشو  11

 

 (Column Drawings) هاستون نقشه کنترل — ۳جدول 

 چک توضیح کنترل  ردیف 

 ☐ تطابق با محاسبات  ابعاد ستون 1۲

 ☐ تعداد، تقارن، فاصله  میلگرد طولی 1۳

 ☐ 1۳5°فواصل، قلاب  ها خاموت 14
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 ☐ ارتفاع ستون   1/ 4خاص در  S ناحیه ویژه قاب خمشی  15

 ☐ Ld/Lap میلگردهای طولیمهاری  1۶

 

 (Shear Wall Drawings) برشی دیوارهای نقشه کنترل — ۴جدول 

 چک توضیح کنترل  ردیف 

 ☐ مطابق محاسبات  ضخامت دیوار  17

 ☐ فاصله، قطر، آرایش  فولاد قائم و افقی 18

1۹ Boundary Elements طول، عرض، خاموت ویژه ☐ 

 ☐ بحرانی در ناحیه غیر  های قائم وصله ۲۰

 ☐ تقویت اطراف  بازشوها  ۲1

 

 (Slab & Floor Drawings) هاسقف و دال نقشه کنترل — ۵جدول 

 چک توضیح کنترل  ردیف 

 ☐ بندییکنواخت یا شیب ضخامت دال ۲۲

 ☐ شبکه بالا/پایین  میلگردهای حرارتی  ۲۳

 ☐ های دوطرفه/یکطرفه دهانه فولاد کششی  ۲4

 ☐ تیرچه تقویتی + میلگرد  بازشو تقویت اطراف  ۲5

 ☐ ها رعایت شودحداقل ها محل قطع و وصله ۲۶

 

 (Foundation Drawings) فونداسیون نقشه کنترل — ۶جدول 

 چک توضیح کنترل  ردیف 

 ☐ و محاسبات  q_all مطابق ابعاد پی ۲7

 ☐ گذاری فاصله، قطر، جهت میلگردگذاری فوقانی/تحتانی ۲8

 ☐ تقویت اطراف ستون  یکطرفه و پانچ برش  ۲۹
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 ☐ لازم برای کشش ها آرماتور تقویتی در گوشه ۳۰

 ☐ همخوانی با معماری  نقشه چاه آسانسور و زیرسازه  ۳1

 

 (Steel Drawings) فولادی نقشه کنترل — ۷جدول 

 چک توضیح کنترل  ردیف 

 ☐ سایز صحیح  پروفیل تیر و ستون ۳۲

 ☐ هابال جان و های تقویتیورق ۳۳

 ☐ ورق روسری/زیرسری ابعاد اتصالات ۳4

 ☐ نوع، اندازه، طول هاجوش ۳5

 ☐ تعداد، گرید، قطر ها پیچ ۳۶

 

 Base Plate و ستون صفحه کنترل — ۸جدول 

 چک توضیح کنترل  ردیف 

 ☐ تناسب با ستون ابعاد صفحه  ۳7

 ☐ کنترل خمش صفحه  ضخامت  ۳8

 ☐ فاصله از لبه  ها محل انکر بولت ۳۹

 ☐ کنترل برش پانچ  های زیرستونپلیت 4۰

 

Architectural) معماری با سازه هماهنگی — ۹جدول   Coordination) 

 چک توضیح کنترل  ردیف 

 ☐ بدون اختلاف محوربندی سازه با معماری  41

 ☐ گذاری درست تیرک بازشوهای پله و آسانسور  4۲

 ☐ جزئیات سازه هماهنگ با  اختلاف ترازها  4۳

 ☐ وال شودسازه نباید مزاحم کرتین عدم تداخل با نما 44
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 (MEP Coordination) تاسیسات با سازه هماهنگی — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ عدم عبور از دیوار برشی  محل رایزرها  45

 ☐ جلوگیری از تداخل با تیرها  ها مسیر داکت 4۶

 ☐ هماهنگی با تیر و کف  تجهیزات سنگین  47

 

 (Detailing QA) جزئیات کنترل — ۱۱جدول 

 چک توضیح کنترل  ردیف 

 ☐ 1۳5 °/ ۹۰ °، خمLd ،Lap ها طول مهاری و وصله 48

 ☐ رعایت شود C_min کاور بتن  4۹

 ☐ شفاف و بدون ابهام گذاری میلگردها شماره 5۰

 ☐ یکپارچه و استاندارد  های نقشه سمبول 51

 ☐ ستون، مرز دیوار -اتصال تیر نقشه جزئیات ویژه  5۲

 

 (Final QA) تحویل از قبل نهایی کنترل — ۱۲جدول 

 چک توضیح کنترل  ردیف 

 ☐ ابعاد، میلگرد، اتصالات  تطابق کامل نقشه با دفترچه محاسبات 5۳

 ☐ گذاری و مقیاس شماره ها یکپارچگی تمام شیت 54

 ☐ ۶،7،۹،1۰،۲8۰۰مباحث  ای نامهآیینرعایت تمام ضوابط  55

 ☐ الزامی  کنترل توسط بازبین سازه  5۶

 ☐ PDF + DWG سازی نسخه نهایی چاپ آماده 57
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 (Seismic Detailing QA) ایلرزه الزامات با هانقشه تطابق کنترل — ۱۳جدول 

 های با اهمیت زیاد + منطقه با خطر نسبی بالاویژه سازه

 چک توضیح تخصصی / معیار کنترل  ردیف

 ☐ (Special Seismic Zones) کنترل محل و طول ناحیه ویژه ناحیه ویژه قاب خمشی در تیر و ستون 58

 ☐ 1۳5 °ویژه = حداقل، با قلاب S هاخاموت ویژه در ستون 5۹

۶۰ Boundary Zone  های ویژهکنترل ابعاد، تراکم آرماتور، و خاموت دیوار برشی ☐ 

 ☐ (Away from plastic hinge) وصله در نواحی غیر بحرانی  ایهای لرزهوصله ۶1

 ☐ اینامه لرزهفاصله خاموت در ستون و مرز دیوار مطابق آیین کنترل کمانش میلگردها ۶۲

 

 (Complex Steel Detailing) های فولادی پیچیدهکنترل نقشه — ۱۴ول جد

 مرکب، مهاربندهای ویژههایی با تیرورق، ستون برای پروژه

 چک توضیح تخصصی / معیار کنترل  ردیف

 ☐ های پیچیده Joint شده ازنمایی وجود نماهای بزرگ Zoom Details کنترل  ۶۳

 ☐ های جانبی و عمودیStiffener کنترل  ها در تیرورقکنندهسخت ۶4

 ☐ مطابق محاسبات Doubler Plate + Stiffener های تقویتی در اتصالاتورق ۶5

 ☐ WPS طول، اندازه، و نوع جوش مطابق هاکنترل ابعاد جوش ۶۶

 ☐ Pitch ،Edge Distanceفاصله پیچ تا لبه،  هاموقعیت پیچ ۶7

 



 

 

 

 

 

 

 

 

 

   وازه نامه  جامع دو زبانه سازه
 



 

 

 سازه زبانه دو جامع نامهواژه — 1۰

 

 (Structural Analysis) سازه تحلیل مفاهیم — ۱جدول 

 توضیح English Term فارسی 

 جایی گره یا عضو نسبت به حالت اولیه بهجا Displacement تغییرمکان

 اختلاف تغییرمکان دو طبقه مجاور  Interstory Drift طبقه دریفت میان

 برابر تغییرمکان افقیمقاومت سازه در  Lateral Stiffness سختی جانبی

 سهم هر مود در پاسخ سازه  Modal Participation Factor ضریب تشدید مودال

 روش ارتقاء مودال برای تحلیل دینامیکی Ritz Modal Method روش مودال ریتز

 

 (Concrete Design) بتن طراحی مفاهیم — ۲جدول 

 توضیح English Term فارسی 

 ظرفیت مقاومت بتن تحت فشار  Compressive Strength (f’c) مقاومت فشاری بتن 

 شود حدی که فولاد وارد ناحیه تسلیم می Yield Strength (Fy) تنش تسلیم فولاد

 ها در دال نوعی گسیختگی در اطراف ستون Punching Shear برش پانچ

 کنترل ترک حرارتی فولاد مورد نیاز برای  Temperature Reinforcement میلگرد حرارتی 

 ناحیه تقویتی در لبه دیوار برشی  Boundary Element ناحیه مرزی 

 

 (Steel Design) فولاد طراحی مفاهیم — ۳جدول 

 توضیح English Term فارسی 

 ناپایداری حول محور اصلی مقطع Flexural Buckling کمانش خمشی

 ناپایداری تیر در اثر پیچش و خم شدن  Lateral Torsional Buckling (LTB) جانبی -کمانش پیچشی

 ورق تقویتی جان ستون در ناحیه اتصال Doubler Plate ورق مضاعف

 تیر فولادی با همکاری دال بتن Composite Beam تیر مرکب 
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 المان انتقال برش در تیر کامپوزیت  Shear Stud برشگیر 

 

 (Foundation & Geotechnical) ژئوتکنیک و پی مفاهیم — ۴جدول 

 توضیح English Term فارسی 

 بیشترین فشار قابل تحمل خاک  Allowable Bearing Capacity ظرفیت باربری مجاز 

 مقدار نشست قابل قبول برای سازه  Allowable Settlement نشست مجاز 

 SAFE سختی بستر خاک در Subgrade Modulus (ks) العمل بستر مدول عکس 

 ها با رفتار متقابل مجموعه شمع Pile Group گروه شمع 

 توزیع فشار در زیر فونداسیون Soil Pressure تنش زیر پی

 

 (Earthquake Engineering) ایلرزه مفاهیم — ۵جدول 

 توضیح English Term فارسی 

 بندی خطر زلزله منطقه Seismic Zone ای پهنه لرزه

 نمودار شدت زلزله برحسب زمان تناوب Design Response Spectrum طیف طرح 

 پذیری کاهش نیرو به علت شکل Response Modification Factor (R) ضریب رفتار 

 ضریب ایمنی اضافی در زلزله  Overstrength Factor (Ω₀) ضریب اضافه مقاومت 

 سازه نیروی افقی کل وارد بر  Base Shear نیروی برش پایه 

 

 (Loading) بارگذاری مفاهیم — ۶جدول 

 توضیح English Term فارسی 

 وزن اجزای ثابت سازه  Dead Load بار مرده 

 زاد بارهای متغیر یا انسان Live Load بار زنده 

 وزن برف روی بام  Snow Load بار برف

 فشار جانبی باد Wind Load بار باد
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 انبساط یا انقباض ناشی از تغییر دما  Temperature Load بار دما

 

 خوانینقشه و اجرایی مفاهیم — ۷جدول 

 توضیح English Term فارسی 

 فاصله فولاد تا سطح بتن  Concrete Cover پوشش بتن 

 همپوشانی دو میلگرد برای انتقال نیرو Lap Splice وصله پوششی

 1۳5 °هایقلابخاموت با  Closed Stirrup خاموت بسته

 پرکاربردترین نوع جوش اتصالات Fillet Weld جوش مارپیچی 

 پلیت اتصال ستون به فونداسیون  Base Plate ستونصفحه

 

 ETABS / SAFE افزارنرم مفاهیم — ۸جدول 

 توضیح English Term فارسی 

 منبع جرم برای تحلیل دینامیکی Mass Source منبع جرم 

 فرض یکپارچگی سقف Rigid Diaphragm دیافراگم صلب

 کردن طیف زلزله مقیاس  Scale Factor فاکتور مقیاس 

 های کوچکتقسیم سطح به المان Meshing بندی مش

 تعیین اجزای قائم و افقی      Pier / Spandrel المانهای دیوار برشی

 

                               QA/QC و کنترلی مفاهیم — ۹جدول 

 توضیح English Term فارسی 

 کنترل فنی توسط مهندس ارشد  Structural Peer Review بازبینی سازه 

 عدم وجود تناقض در ابعاد و آرماتور Drawing–Report Match همخوانی نقشه و دفترچه 

 تحویل بررسی قبل از  Final Structural QA کنترل نهایی پروژه 

 نظارت بر اجرا Site QC کنترل اجرایی
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 چک لیست نهایی تحویل پروژه
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 (Submission Documents) تحویلی مدارک کنترل — ۱جدول 

 چک توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ شامل مدل نهایی، بدون خطا  ETABS فایل 1

 ☐ شامل طراحی فونداسیون و خروجی کامل SAFE فایل ۲

 ☐ هماهنگ با دفترچه محاسبات  (DWG) هافایل نقشه ۳

 ☐ نسخه نهایی، امضا شده  دفترچه محاسبات  4

 ☐ بندی صحیح خوانا، لایه ها نقشه PDF فایل 5

 

 (Cross-Consistency) مدارک بین سازگاری کنترل — ۲جدول 

 چک توضیح کنترل  ردیف 

 ☐ ابعاد، میلگرد، جزئیات  ها با دفترچه هماهنگی نقشه ۶

 ☐ سازیمقاطع، بارگذاری، مدل  ها با نقشه ETABS هماهنگی 7

 ☐ ابعاد پی، آرماتورگذاری ها نقشهبا  SAFE هماهنگی 8

 ☐ بازشوها، پله، آسانسور  سازه –هماهنگی معماری ۹

 ☐ ها رایزرها، داکت تأسیسات –هماهنگی سازه 1۰

 

 (Code Compliance) اینامهآیین موارد کنترل — ۳جدول 

 چک معیار  کنترل  ردیف 

 ☐ DL, LL, WL, EQ )بارگذاری( ۶کنترل مبحث  11

 ☐ طراحی کامل  )بتن(  ۹کنترل مبحث  1۲

 ☐ اعضا + اتصالات )فولاد( 1۰کنترل مبحث  1۳

 ☐ نشست   q_all + )فونداسیون(  7کنترل مبحث  14
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 ☐ دریفت، پهنه، طیف  ۲8۰۰کنترل  15

 

Final) نهایی سازیمدل هایکنترل — ۴جدول   Modeling QA) 

 چک توضیح کنترل  ردیف 

 ☐ مدل پاک و بدون خطاست Joint Unassigned بدون 1۶

 ☐ ها کنترل مفصل اشتباه  Frame Release بدون 17

 ☐ Rigid/ Semi-Rigid بندی کاملدیافراگم 18

 ☐ تکراری حذف شود  DL/LL شده حذف بارهای دوباره اعمال 1۹

 ☐ برای دیوار و دال Mesh کنترل ۲۰

 

 (Analysis QA) تحلیل کنترل — ۵جدول 

 چک توضیح کنترل  ردیف 

 ☐ X/Y جهت ٪۹۰ ≤مشارکت مودال  ۲1

 ☐ ۰.۰۲5h ≥ دریفت در محدوده مجاز  ۲۲

 ☐ SP ≥ ۰.8 EQstatic سازی برش پایه همپایه ۲۳

 ☐ مجاز  P–Δ θ کنترل ۲4

 ☐ هندسی/جرمی/پیچشی  ها کنترل نامنظمی ۲5
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 (Concrete Design QA) بتن طراحی کنترل — ۶جدول 

 چک توضیح کنترل  ردیف 

 ☐ خمشی/برشی/پیچشی طراحی تیر  ۲۶

 ☐ Interaction Diagram طراحی ستون  ۲7

 ☐ Boundary طراحی دیوار برشی ۲8

 ☐ ها ها و دالستون SAFE کنترل برش پانچ ۲۹

 ☐ آنی/بلندمدت  کنترل خیز  ۳۰

 

 (Steel Design QA) فولاد طراحی کنترل — ۷جدول 

 چک توضیح کنترل  ردیف 

 ☐ /LTBخمشی/برشی طراحی تیر فولادی  ۳1

 ☐ کمانش  طراحی ستون فولادی ۳۲

 ☐ CBF / EBF طراحی مهاربند  ۳۳

 ☐ پیچ/جوش/ورق  طراحی اتصالات  ۳4

 ☐ Base Plate طراحی صفحه ستون  ۳5

 

 (SAFE Foundation QA) فونداسیون کنترل — ۸جدول 

 چک توضیح کنترل  ردیف 

 ☐ q ≤ q_all کنترل تنش زیر پی  ۳۶

 ☐ Vu ≤ φVn کنترل برش یکطرفه  ۳7

 ☐ های میانی و کناریستون کنترل برش پانچ  ۳8

 ☐ ژئوتکنیک  کنترل نشست کل و اختلافی  ۳۹

 ☐ Cap + Pile Layout کنترل گروه شمع  4۰
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 (Drawing QA) هانقشه با مرتبط هایکنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ تاریخ، شماره شیت  ها تیتر نقشه 41

 ☐ دقیق و خوانا  میلگردگذاری تیر/ستون 4۲

 ☐ کامل، بدون ابهام اتصالات فولادی  4۳

 ☐ تنش و آرماتورگذاری  نقشه فونداسیون 44

 ☐ پلان/برش/جزئیات  ها عدم تعارض بین شیت 45

 

 (Final Submission) تحویل نهایی کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ یکپارچه، کیفیت بالا  نهایی  PDF فایل 4۶

 ☐ بندی استانداردلایه DWG فایل 47

 ☐ گذاری استانداردنام ETABS/SAFE هایفایل 48

 ☐ الزامی  تأیید طراح و بازبین  4۹

 

 (File Management QA) فایل مدیریت و هاپوشه ساختار گذاری،نام کنترل — ۱۱جدول 

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ : ProjectName_ETABS_vFinal_1403-11-01 مثلاً ETABS/SAFE هایگذاری فایلنام 51

 ☐ ETABS / SAFE / Drawings / Calculations / Reports: بندیپوشه ساختار پوشه پروژه  5۲

 ☐ (Backup, _temp, _old) های موقتهای تست، فایلحذف نسخه های اضافیعدم وجود فایل 5۳

 ☐ Finalو  Draftهای داشتن حداقل نسخه بندی صحیحنسخه 54

 ☐ ها باید نام و تاریخ هماهنگ داشته باشند همه فایل ها با نقشه و دفترچه تطابق نام فایل 55
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 (Drawing & Document Quality) مدارک و هانقشه کیفیت نهایی کنترل — ۱۲جدول 

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ Missing Font رزولوشن مناسب، بدون PDF خوانایی فایل 5۶

 ☐ های خراب ها، عدم وجود بلاک سالم بودن لایه DWG کیفیت خروجی 57

 ☐ بدون تغییر نسبت مقیاس A1/A3 چاپ صحت مقیاس در چاپ  58

 ☐ ها پوشانی متنفونت استاندارد، عدم هم ها کنترل نهایی متن 5۹

 ☐ یکتایی شماره شیت و بدون تکرار ها شماره شیت ۶۰

 

 (Client & Reviewer Submission QA) ناظر/کارفرما به تحویل کنترل — ۱۳جدول 

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ شامل لیست کامل مدارک، تاریخ، مهر دفتر  (Transmittal Letter) نامه تحویل ۶1

 ☐ با مهر مهندسین  A3/A1 هاینقشه ارسال نسخه چاپی ۶۲

 ☐ با ساختار پوشه استاندارد  DVD/USB روی ارسال نسخه دیجیتال  ۶۳

 ☐ الزامی و قابل پیگیری  امضای طراح، محاسب، بازبین  ۶4

 ☐ شدهتحویل رسمی و ثبت تأییدیه نهایی کارفرما  ۶5

 

 (Model Archiving QA) آرشیو از قبل نهایی مدل کیفیت کنترل — ۱۴جدول 

 (های بعدیبسیار مهم برای بایگانی مهندسی و جلوگیری از خطا در نسخه)  

 چک توضیح تخصصی / معیار  کنترل  ردیف 

 ☐ (Test / Temp / Check) های غیرضروری Load Case عدم وجود های تستیLoad Case حذف ۶۶

 ☐ (Model1 / Model2 / TestModel) های موازی و ناقصحذف مدل  های فرعیحذف مدل  ۶7

 ☐ در کل مدل  kN–m–C اطمینان از استفاده از سازی واحدها یکپارچه ۶8

 ☐ تحویلجلوگیری از تغییر ناخواسته پس از  Read-Only ذخیره نسخه نهایی ۶۹

 ☐ ذخیره نسخه نهایی در آرشیو پروژه  نهایی  Backup تهیه فایل 7۰
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 (Design QA & Peer Review) سازه طراحی  کیفیت  کنترل  لیست چک  — 1۲

 

 (Modeling Quality Assurance) سازیمدل کیفیت کنترل — ۱جدول 

 چک توضیح تخصصی / معیار  مورد کنترل ردیف 

 ☐ تطابق کامل با معماری  Grid/Story سازی صحیحمدل  1

 ☐ بتن/فولاد با مشخصات درست  تعریف صحیح مصالح  ۲

 ☐ تیر، ستون، دیوار بر اساس نقشه  اعضا مقاطع صحیح   ۳

 ☐ مدل پاک و بدون خطا Joint Unassigned عدم وجود 4

 ☐ عدم اعمال اشتباه  ها  Offset کنترل 5

 ☐ صحیح برای قاب خمشی Rigid Zone Factor کنترل ۶

 

 (Loading QA) بارگذاری کیفیت کنترل — ۲جدول 

 چک توضیح کنترل  ردیف 

 ☐ ۶مبحث  DL/LL/WL/SL/EQ تعریف کامل 7

 ☐ تعریف شده باشد = Self Weight 1 کنترل 8

 ☐ صحیح  Partition Load بندیکنترل بارهای تیغه ۹

 ☐ Live درصدی از+   Mass Source Dead کنترل 1۰

 ☐ تیر + سقف  کنترل عدم بارگذاری مضاعف  11

 ☐ EX/EY – WX/WY کنترل جهت باد و زلزله  1۲

 
  



 7۹             سازه طراحی کیفیت کنترل لیستچک  

 

 (Analysis QA) تحلیل کیفیت کنترل — ۳جدول 

 چک معیار  کنترل  ردیف 

 ☐ X/Y ٪۹۰ ≤مشارکت جرمی  1۳

 ☐ SP ≥ ۰.8 EQstatic سازی برش پایه همپایه 14

15 Drift ۰.۰۲5 ≥ طبقه میانh ☐ 

 ☐ پیچشی/جرمی/هندسی  ها کنترل نامنظمی 1۶

 ☐ مجاز  P–Δ θ کنترل 17

 ☐ مود پیچشی غیرمنتظره  غیرمنطقی کنترل مودهای  18

 

 (Concrete Design QA) بتن طراحی کیفیت کنترل — ۴جدول 

 چک توضیح کنترل  ردیف 

 ☐ خمش، برش، پیچش  طراحی تیر  1۹

 ☐ اندرکنش  طراحی ستون  ۲۰

 ☐ Boundary Element طراحی دیوار برشی ۲1

 ☐ SAFE Punching برش پانچ ۲۲

 ☐ مدت/بلندمدت کوتاه کنترل خیز  ۲۳

 ☐ As_min / As_max کنترل حداقل/حداکثر فولاد ۲4

 ☐ Lap ،Hook ،Cover ها کنترل وصله ۲5

 
  



 ولادی ف و  وکنترل سازه های بتنی   چک لیست مدل سازی،طراحی     8۰

 

 (Steel Design QA) فولاد طراحی کیفیت کنترل — ۵جدول 

 چک توضیح کنترل  ردیف 

 ☐ LTBخمشی، برشی،  طراحی تیر  ۲۶

 ☐ لاغری، کمانش  طراحی ستون  ۲7

 ☐ عملکرد فشاری/کششی مهاربند طراحی  ۲8

 ☐ پیچ، جوش، ورق طراحی اتصالات  ۲۹

 ☐ Shear Stud ،Mn_comp طراحی تیر مرکب  ۳۰

 ☐ Base Plate طراحی صفحه ستون  ۳1

 

 (Foundation Design QA) فونداسیون طراحی کیفیت کنترل — ۶جدول 

 چک توضیح کنترل  ردیف 

 ☐ q q ≤ q_all کنترل تنش ۳۲

 ☐ Vu ≤ φVn برش یکطرفه  ۳۳

 ☐ های کناری/میانی ستون برش پانچ ۳4

 ☐ ΔS و S کنترل نشست  ۳5

 ☐ Qa ظرفیت کنترل شمع و گروه شمع  ۳۶

 

 (Drawing–Model QA) مدل و نقشه بین هماهنگی کنترل — ۷جدول 

 چک توضیح کنترل  ردیف 

 ☐ عدم اختلاف ETABS مقاطع تیر و ستون مطابق ۳7

 ☐ برش پانچ/خمشی  SAFE میلگردگذاری طبق ۳8

 ☐ گذاری و بازشوتیرک هماهنگی پله/آسانسور  ۳۹

 ☐ عدم تداخل با سازه  هماهنگی نما  4۰
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Documentation) مستندسازی کیفیت کنترل — ۸جدول   QA) 

 چک توضیح کنترل  ردیف 

 ☐ صحیح و یکتا  هاگذاری جدولشماره 41

 ☐ هماهنگ ها شکلگذاری شماره 4۲

 ☐ ها مبحث  ACI / AISC/ دهی استانداردرفرنس 4۳

 ☐ درست LaTeX ها صحت فرمول 44

 ☐ فونت/فاصله خطوط  خوانایی دفترچه  45

 
 (Drawing QA) هانقشه کیفیت کنترل — ۹جدول 

 چک توضیح کنترل  ردیف 

 ☐ 1:1۰۰،  1:5۰ مقیاس صحیح  4۶

 ☐ سازه/معماری  ها پلاننبود اختلاف بین  47

 ☐ اندازه و فونت مناسب  میلگردگذاری خوانا  48

 ☐ پیچ/جوش صحیح  اتصالات دقیق 4۹

 ☐ ابعاد، ضخامت  ها صفحه ستون 5۰

 

 (Peer Review QA) همتراز بازبینی کنترل — ۱۰جدول 

 چک توضیح کنترل  ردیف 

 ☐ تأیید کامل بازبینی مهندس ارشد  51

 ☐ تطابق نیروها  ETABS هایخروجیبررسی مجدد  5۲

 ☐ تطابق برش/پانچ SAFE بررسی مجدد خروجی 5۳

 ☐ تیر/ستون نمونه  بررسی دستی تعدادی از اعضا  54

 ☐ آماده تحویل لیست نهایی تکمیل شده چک 55



 

 

 سخن پایانی : 
 

همکار ارجمند ، دانشجوی گرامی این مجموعه جهت استفاده شما عزیزان تهیه و تدوین گردیده است . سپاسگزار خواهیم بود که در صورت 
 گروهها و کانالها به رسم امانت نسبت به ذکر منبع اقدام فرمائید.، انتشار در سایتها 

نیز جهت نصب در گوشی های اندروید منتشر می گردد که می توانید نسبت APK بصورت فایل نصبی     PDFهر آموزش منتشر شده بصورت فایل
 به دانلود آن از کانال و نصب آن صرفا"در گوشی های با سیستم اندروید اقدام فرمائید.

از چک لیستها و کنترلهای هرگونه استفاده غیر تجاری از این مجموعه کاملا آزاد می باشد و از اینکه در فرآیند طراحی شما عزیز گرامی شاید بخشی  
 خوشحالیم.  ضروری را نظام مند کرده باشیم

بدیهی است انتشار هر مجموعه در طی فرآیندهای تالیف ، تایپ ، ویراستاری و ... ممکن است براثر اشتباهات انسانی هر چند کوچک خالی از 
 اشکال نباشد لذا خواهشمندیم هرگونه اشکال و ایراد را جهت رفع و اصلاح به ما یاد آوری فرمائید.

 
فرهاد آزادپوربا سپاس  
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